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Enhancements

ÁPre/Post Processing

1. Addition of Automesh 

2. Definition of Domain/Sub-domain 
for slab and wall design

ŀƴŘ ƳǳŎƘ ƳƻǊŜΧ

ÁAnalysis part

1. Applying Plate and Solid Elements 
to Structural Masonry Material 

2. Addition of Time Dependent Material 
as per Eurocode2:04

ŀƴŘ ƳǳŎƘ ƳƻǊŜΧ

ÁDesign part

1. Addition of Capacity Design as per NTC2008 and 
Eurocode8-1:2004

2. Addition of Slab/Wall Design as per Eurocode2-
1-1:2004

ŀƴŘ ƳǳŎƘ ƳƻǊŜΧ
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Gen 2010 (v1.1) Release Note

(1) Addition of Automesh 

(2) Definition of Domain/Sub-domain for slab and wall design 

(3) Addition of Create Converted Line Elements function

(4) Assigning Wind and Seismic Load for Flexible Floors

(5) Improvements in Beam Wizard

(6) Addition of composite section tab

(7) Addition of upside-down T-shape beam

(8) Improvements in IS84 section DB

(9) Addition of Chinese section DB: GB-YB05

(10) Assigning Inertial Forces of RS analysis into Nodal  Loads

(11) Addition of Cutting Diagram Display for Plane Strain elements 

(12) Display Stiffness for Rigid Type Elastic Link in the Analysis Output File 

(13) Shading for Solid and Planar Elements in Wireframe View

(14) Display element color by element types, material types or section 
types 

(15) Improvements on the Display of Supports  and Point Spring Supports

(16) Addition of an export to Excel feature in result tables

(17) Save an image in jpg format 

(18) Export frame model to solid/plate model 

(19) Addition of Sort Groups by Name feature 

(20) Renumbering the existing element  numbers in the reversed order

(21) Addition of the Preference in online help

(22) Addition of auto-generation of wind loads 

according to the latest Korean Building Code (KBC2008)

(23) Addition of static and dynamic seismic loads 

according to the latest Korean Building Code (KBC2008)

ÇDetailed Enhancement List in Pre & Post processing
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Mesh generationfeature is newly implementedfor slaband wall members. Generatedmesh

elementsare fully compatiblewith analysisanddesignfeature. Automeshconsideringinterior

nodes,elementsandopeningsisavailable.

Automesh 4 NodesMap-mesh

Using Auto-mesh Planar Area

function, we can generate

meshes for various shapes of

areas. In order to specify the

area, select the corresponding

Nodes,Line elements or Planar

elements.

Using Map-mesh 4-Node Area

function, we can generate

regular shape of meshesfor 4-

nodes area. We can specify the

number of divisionsfor x and y-

axisseparately.

Automesh and Map-mesh

1. Addition of Automesh

Model > Mesh > Auto-mesh Planar Area

Model > Mesh > Map-mesh 4-Node Area
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Checkon Mesh Inner Domainoption to

generatemeshesin the interior openings.

When this option is checked off, the

program automatically recognize the

closedareasand meshelementsare not

generated in the corresponding areas.

Defaultsettingischeck-off.

Mesh Inner Domain option

Include Interior Nodes/Lines option

Checkon to considernodesor lineswhen

generating meshes. In order to specify

nodes and lines, auto and user defined

methodsareavailable.

IncludeInterior Linesoption canconsider

beam,planerandsolidelements.

Boundary Connectivity

Boundaryconnectivityfor adjacentareas

isautomaticallyconsidered. If the userdo

not want to consider the boundary

connectivity by intention, the user can

check off IncludeBoundaryConnectivity

option. Defaultsettingischeck-on. Meshing

Meshing

Meshing

Meshing
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Check on Delete Source Line Element

option to delete line elements when

generatingmeshes. When this option is

checked off and SubdivideSource Line

Elementoption is check-on, line elements

will bedividedalongthe meshsize.

Delete Boundary Line Element

When mesh elements are generated,

Boundaryline elementsare dividedalong

the meshsize. Dividedline elementsare

assignedasonememberfor design.

This option is activated when Delete

SourceLineElementoption ischeck-off.

Subdivide Boundary Line Element

Meshing

Meshing

When mesh elements are generated,

predefined loads are automatically

redistributedalongthe meshelements.

Re-distribute pressure loads

Meshing
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Automesh and design procedure

Parapet Automesh (Extrude : Line -> Planar)

Analysis & Design

Copy

Slab Automesh

Make a polygon for meshing
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2. Definition of Domain/Sub-domain for slab and wall design 

Model > Mesh > Auto-mesh Planar Area

Model > Mesh > Map-mesh 4-Node Area

Domain

[1]

[2]

[3]

[4]

Sub-Domain

Meshing

Domainis automaticallydefinedwhen generatingmeshes. Elementswhichare definedasone

Domaincanhavethe identicalelementtype,materialpropertyandthickness.

One domain consistsof severalsub-domainswhich representeachslabspan. For eachsub-

domain,we canspecifythe rebardirectionfor slabdesign

Rebar direction
Dir.1: Angle of rebar from Global X-axis
Dir.2: Angle of rebar from Dir.1

X

Y

1

Dir. 1

Dir. 2

GCS
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Generate line beam elements on the outlines of the planar elements. When Create only on 

Periphery Regionoption is checked on, beam elements are generated on the outmost lines 

only. This function is useful to create line elements after meshing plate elements. 

Simultaneous conversion 
by multiple selection

WhenCreate Only on Periphery Region option 
is checked-on

When Create Only on Periphery Regionoption 
is checked off

Model > Element > Create Converted Line Elements

3. Addition of Create Converted Line Elements function
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Model > Building > Control Data

Wind Load

Seismic Load

Concentrated Load Torsion

Concentrated Load Torsion

4. Assigning Wind and Seismic Load for Flexible Floors

Automatically calculate static wind and seismic loads for floors for which floor diaphragm is 

not considered. In the old version, static wind and seismic loads was not able to be assigned if 

floor diaphragm is not considered. 
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Span-oriented input type for Beam Wizard is newly implemented. In the new version, beam 

elements with different spans can be rapidly generated.

Type 1: Generate beam elements based on the beam length. Beam elements with different 

lengths can be generated simultaneously. (Ex. 5.0, 3.0, 4.5, 3@5.0) 

Type 2: Generate beam elements based on the distance between the nodes and the number 

of repetitions. 

Model > Structure Wizard > Beam

Old version Gen 2010

5. Improvements in Beam Wizard
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Compositesectiontab for consideringthe sectionvariationbeforeandafter compositeactions

hasbeennewlyadded. Compositesectionprovidesfollowingthreesectiontypes:

Steel-Box:Structural steel Box Girder

Steel -I: Structural Steel I Shape Girder

User:{ŜŎǘƛƻƴ ǇǊƻǇŜǊǘƛŜǎ ŘŜŦƛƴŜŘ ŀǎ ΨDŜƴŜǊŀƭ {ŜŎǘƛƻƴΩ ƛƴ ǘƘŜ ±ŀƭǳŜ ǘŀō

Model > Properties > Section

Tables >Structure Tables > Properties > Section

6. Addition of composite section tab

Steel-Box type

Steel-I type



Gen 2010Enhancements in pre/post processing Gen 2010 (v1.1) Release Note

13/ 64

Generatethe strip foundationsusingupside-down T-shapebeam. Both upside-down T-shape

andL-shapesectioncanbe generated. Thissectionis usefulto generatestrip foundationsof a

building. Designfeature for upsidedown T-shapebeamshallbe implementedin the upcoming

version.

Model > Properties > Section

Tables >Structure Tables > Properties > Section

Upside-down T-shape section L-shape section

7. Addition of upside-down T-shape beam
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In IS84 sectionDB,H-SectionandChannelnow

reflectΨǊΩvalue.

Also T-Sectionhas been newly added as per

IS84.

8. Improvements in IS84 section DB

ChinesesectionDB(GB-YB05) hasbeennewly

added. Followingsectionshapesare available

basedon GB-YB05:

Angle, Channel, I-section, T-section, Box,

Pipe, Double angle, Double channel,Cold

formed channel

9. Addition of Chinese section DB
(GB-YB05)

Model  >  Properties  > Section

Tables >Structure Tables > Properties > Section
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Inertial forcesresultingfrom responsespectrumanalysiscan be convertedto nodal loadsin

the specifiedloadcase. Theprocedureisasfollows:

¡ In the 'NodalResultsof RS'table,right-clickandselect'Convertto NodalLoad'menu.

¢ In the 'Convertto NodalLoad'dialog,selectdesiredRSloadcaseandMode.

'Combined'componentof Moderepresentsmodalcombinationresults.

£Selector createloadcaseto generatethe nodalloads.

Results  >  Result Tables  > Nodal Results of RS

10. Assigning Inertial Forces of RS analysis into Nodal  Loads

3
2

1
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Cutting diagram can be displayedfor

plane strain elements. In the old

version, it was available for plate

elementsonly.

Checkcutting diagram in contour for

2-D structureswhich consistof plane

strain elements such as dams,

breakwaters, tunnels and retaining

walls.

Results  >  Stresses > Plane Strain Stresses

11. Addition of Cutting Diagram Display for Plane Strain elements

Model > Boundaries > Elastic Link

Analysis > Perform Analysis

Stiffnessof rigid typeelasticlink arenow producedin the analysisoutput file (*.out).

12. Display Stiffness for Rigid Type Elastic Link in the Analysis Output File
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Shading

View > Display Option

Shadingoption for solid and planer elementsis newly implemented. In addition, the user can

adjustthe transparencyfor shadingdisplay.

13. Shading for Solid and Planar Elements in Wireframe View

Randomelement color can be automaticallydefined by element types, material types or

sectiontypes.

For pre-generated 
elements, assign 
random element 
color by properties 
by clicking 
[Random Color] 
button.

For newly created 
elements, assign 
random element 
color by properties  
by checking on 
Ψ!ǎǎƛƎƴ wŀƴŘƻƳ 
/ƻƭƻǊΩ ƻǇǘƛƻƴΦ

View > Display Option

14. Display element color by element types, material types or section types 

Draw tab Color tab
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A new feature that displaysthe Supportand Point SpringSupportoffering an intuitive way of

identifyingboundaryconditions.

Model > Boundaries > Define Constraint Label Direction

View > Display > Boundary

Old version

Gen 2010
Support Point spring support

15. Improvements on the Display of Supports and Point Spring Supports
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New feature that can export databasesto an ExcelSpreadsheet. Tabletitles are exported as

well asvalues. Thisfeatureisavailablefor all the pre andpost-processingtables.

Results > Result Tables 

16. Addition of an export to Excel feature in result tables

File > Graphic files > JPG files

Graphicdata of the Model Window canbe

saved in jpg format as well as AutoCAD

DXF,BMPor EMF.

17. Save an image in jpg format 
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File  >  Export  > Frame Section for Solid, Frame Section for Plate

[midas Civil: line beam model]

[midas FEA: Imported tendons]

[midas FEA: Solid model]

TendonProfilesaswell asconcretegirdercanbeexportedto midasFEAfor detailanalysis.

Exportingframemodelto platemodelin midasFEAisnewlyimplemented.

The user can easilygeneratethe solid/plate model with tendons,which will be analyzedin

midasFEA.

18. Export frame model to solid/plate model 
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In the old version, if  a 
ǎǘǊǳŎǘǳǊŜ ƎǊƻǳǇ Ψ{ŜƎр-мΩ 
is newly created, it was 
located at the 
bottommost of the group 
list. 

In Gen 2010, the user

can change the group

order based on the

constructionsequence.

Model  >  Group  > Define Structure (Boundary / load / Tendon) Group

Automaticallyput a list of groupsin alphabeticalorderor individuallychangegrouporder.

Thisfeature helpsthe user quicklyorganizeand understandgroup data better especiallyfor

constructionstageanalysis.

Old version

Gen 2010

19. Addition of Sort Groups by Name feature
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In Gen 2010, (-)X, (-)Y and (-)Z directions 

are newly added.

102

103

201

202

203

204

301

302

303

304

305

401

402

403

101 reversed 
order

1

2

3

4

5 6 7 8

9

10

11

12

reversed 
order

Model  >  Nodes  > Renumbering

Renumberthe existingelement(node)numbersin the reversedorder for the GCSdirection.

Forpile or frameelements,renumberthe element(node)numbersin the directionof gravity.

Model >  Elements  > Renumbering

Pile elements

Frame

20. Renumbering the existing element (node) numbers in the reversed order
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Theusercanselecta LocalHelpor Web-basedHelpin the preference.

WhenΨ¦ǎŜLocalIŜƭǇΩoption is checkedon, a Localhelp file (midasGen.chm)whichhasbeen

installedin the localcomputeris invokedbypressingΨC1Ωkey.

Default setting is check-off, which invokesa Web-basedHelp. SinceWeb-basedHelp can be

frequentlyupdated,defaultsettingis recommended.

[Web-based Help]

21. Addition of the Preference in online help

Tools > Preferences > Notice & Help
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Rigid Structure

Auto-generationof wind loadsaccordingto KBC2008isnewlyimplemented.

In KBC2005, GustEffectFactorwasdeterminedbasedon the Roughnessin the corresponding

tablefor the rigid frame. In KBC2009, it iscalculatedfrom the equation.

Load > Lateral Loads > Wind Loads

22. Addition of auto-generation of wind loads 
according to the latest Korean Building Code (KBC2009)

Flexible Structure
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Static seismicload and designresponsespectrumaccordingto KBC2009 have been newly

added.

Load > Response Spectrum Analysis Data 
> Response Spectrum Functions

Load > Lateral Loads 
> Static Seismic Loads

23. Addition of static and dynamic seismic loads 
according to the latest Korean Building Code (KBC2009)
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(1) Applying Plate and Solid Elements to Structural Masonry Material 

(2) Addition of Time Dependent Material as per Eurocode2:04

(3) Addition of Time Dependent Material as per IRC:18-2000

(4) Addition of the Time Dependent Material (Compressive Strength) 
as per CEB-FIP(1978) 

(5) Addition of distributed springs

(6) Addition of Pile Spring Supports 

(7) Addition of Multi-Linear Type Elastic Link

(8) Nonlinear Point Spring Supports for Construction Stage Analysis

(9) Consider Accidental Eccentricity for Response Spectrum Analysis 
in Basement Floors

(10) Considering Mass Participation Factor for Rotational direction

(11) Transfer reactions of slave nodes to the master node

(12) Improvements in Buckling Analysis Control dialog 

(13) Improvements on the Eigenvalue analysis considering the 
maximum number of frequencies

(14) Improvement on FEMA type pushover hinge properties 

(15) Considering buckling load in the Pushover Yield Surface 

(16) Considering the effects by self-weight in pushover analysis 

(17) Improvements in Inelastic Hinge Properties of SRC Beam member

ÇDetailed Enhancement List in Analysis
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1. Applying Plate and Solid Elements to Structural Masonry Material

Plate elements,4-nodes tetra solid and 6-nodes wedge solid elements can be applied for

StructuralMasonrymaterialfor plasticanalysis.

Model > Properties > Plastic Material



Gen 2010Enhancements in analysis part Gen 2010 (v1.1) Release Note

28/64

2. Addition of Time Dependent Material as per Eurocode2:04

Time DependentMaterial (Creep/Shrinkage,CompressiveStrengthand TendonLoss)as per

Eurocode2:04 isnewlyimplemented.

Model > Properties > Time Dependent Material(Creep/Shrinkage)

Model > Properties > Time Dependent Material(Comp. Strength)

Load > Prestress loads > Tendon Property

Creep/Shrinkage

Compressive Strength Tendon Loss
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3. Update on Time Dependent Material as per IRC:18-2000

Time Dependent Material (Creep/Shrinkage, Compressive Strength and Tendon Loss) as per 

IRC18:2000 is newly implemented.

/ǊŜŜǇ ŦǳƴŎǘƛƻƴ Ŏŀƴ ōŜ ǎƘƻǿƴ ŀǎ άŎǊŜŜǇ ǎǘǊŀƛƴ ǇŜǊ млatŀέ ŀǎ ǿŜƭƭ ŀǎ ά/ǊŜŜǇ /ƻŜŦŦƛŎƛŜƴǘέΦ 

¬Creep/Shrinkage

Compressive Strength Tendon Loss

Model > Properties > Time Dependent Material(Creep/Shrinkage)

Model > Properties > Time Dependent Material(Comp. Strength)

Load > Prestress loads > Tendon Property
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4. Addition of the Time Dependent Material (Comp. Strength) 
as per CEB-FIP(1978) 

Time Dependent Material (Compressive Strength) as per CEB-FIP(1978) is newly implemented. 

In the old version, only creep and shrinkage as per CEB-FIP(1978) were implemented. For the 

construction stage analysis, time dependent material as per CEB-FIP(1989) can be now  fully 

considered. 

Model > Properties > Time Dependent Material (Comp. Strength)

Ç Implemented time dependent material codes:

CEB-FIP(1990)

CEB-FIP(1978)

ACI209(1982)

PCA(1986)

Combined ACI & PCA

IRC:18-2000

Eurocode2-1-1:2004
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5. Addition of distributed springs

Distributed springs on the beam, plate and solid elements .

Generate surface springs to represent the stiffness of the soil.

Consider accurate boundary conditions when modeling members on elastic subgrade. 

Compression-only spring can be considered.

Model > Boundaries > Surface Spring Supports

ÇDifference between Convert to Nodal Spring and Distributed Spring

When Convert to Nodal Spring is selected, springs are entered at the nodes of the 
elements. When Distributed Spring is selected, springs are uniformly distributed on 
a face or edge of the elements.

Convert to Nodal 
Spring

Distributed Spring 
(Winkler Spring)

Spring 
location

Nodes of elements Distributed on the elements 

Unit of 
reaction

kN
Beam: kN(kN/M)

Planar or Solid: kN(kN/M2)

Deformation
Concentrated
at the nodes 

As element stiffness increases, 
deformations are distributed throughout 

the elements.

[Surface Spring Supports Display]

[Reaction (Local-Surface Spring )tab]
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6. Addition of Pile Spring Supports

Pile spring support can consider the soil adjacent to piles as nonlinear springs. Nonlinear

characteristicsof springsoverthe pile heightareautomaticallyvaried.

Linear, compression-only and Multi-Linear springs are automatically assigned to nodes

dependinguponthe springdirection.

By selectingthe pile elementsand entering geometrydata (ground level, pile diameter, etc.)

andsoilproperties,the springstiffnessat eachnodeisautomaticallycalculated.

Linear type

Point Spring Support

Model > Boundaries > Point Spring Support Table

Multi-Linear type

Point Spring Support

Model > Boundaries > Pile Spring Supports
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: Angleof internal friction of sand

:

:

: Unit weightof soil

: Activeearthpressurecoefficient

The relationship between the lateral soil resistance and the lateral displa

cement Y at a specific depth X is represented as shown in the left figure.

The values of Pk, Pm, Pu, Yk, Ym and Yu are defined at a specific depth

(i.e., where pile springs are).

The method of calculating Pu varies with Soil Types. The values of Pk, P

m, Yk, Ym and Yu are calculated using Pu as explained below.

The calculation method is divided into two major cases - Sand and Clay.

Different J values are used for Soft Clay and Stiff Clay, respectively.

ÇThe Stiffness of Nonlinear Elastic (Lateral) Springs for the Soils adjacent to Piles 

a. Calculation of Pu in case of Sand Soil

The value of Xt denotes the depth when the following two Pu values are equal. Make the right terms of two equati

ons equal, rearrange the equation in terms of X and solve the quadratic equation.

) ti X X< ) tii X X>

1 2 3 4[ ]u rP A X c c c c= + + - 5 6[ ]uP AD c c= +

0

1

tan sin

tan( )cos

K X
c

f b

b f a

¡
=

¡-

2

tan
( tan tan )

tan( )
c D X

b
b a

b f
= +

¡-

3 0 tan (tan sin tan )c K X b f b a¡= -

4 ac K D=

8

5 (tan 1)ac K rX b= -

4

6 0 tan tanc K rX f b¡=

: Ultimatesoil resistanceper unit length

: Empiricaladjustmentfactor

: Depthbelowsoilsurface

: Pilediameter

: Coefficientof earthpressureat rest

uP

A

X

D

0K aK

f¡

a

b

g

2[tan (45 / 2)]f¡¯-

/ 2f¡

45 / 2f¡¯+

Where, Where,
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: Empiricaladjustmentfactor

: Constantvaryingwith relativedensity

: Pilediameter

: Empiricalconstant(0.5 for SoftClay,0.25for Stiff Clay)

: Depthbelowsoilsurface

:

b. Calculation of Pu in case of Clay Soil 

Where,

[3 / ]u u uP D s rX Jc X D= + +

9u uP s D=

RX X¢

RX X²

uP

us

uc

g

D

J

X

RX 6 /[ / ]uD s Jns¡ +

: Ultimate resistanceper unit length

: Undrainedshearstrength

: Undrainedcohesion

: Unit weightof soil

for

for

c. Computation of Points k and m

3

80
u

D
Y =

60
m

D
Y =

m u

B
P P

A
= Ö

/(1 )

1/1

n n

n

m

DPm
Yk

k XY

-

å õ
=æ ö
ç ÷

1( / )k kP X D k Y=

,A B

[ ( )] /[ ( )]m u m m u mn P Y Y Y P P= - -

1k

2

1( / / )k MN m m

d. Spring Stiffness

The final spring stiffness is determined by multiplying the stiffness per unit area calculated above by the area.

u uP P A= ³ m mP P A= ³ k kP P A= ³

Where,
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Where, : Pilediameter : Coefficientof earthpressureat rest

: Unit weightof soil : Depthbelowsoilsurface

: Internal friction angle

ÇThe Stiffness of Linear Elastic (Vertical) Springs for the Soils adjacent to Piles 

Thedirectionof the linearelasticverticalspringsfor the soilsadjacentto pilesshouldbe perpendicular

to the ground (GCS'-'Z direction). Eventhough the piles are not perpendicularto the ground, the z-

direction(NodeLocalAxis)of the nodesfor Pilesshouldcoincidewith the GCSZ-direction.

tan 0 tanK D K g f¡= ³ ³ ³

tan (1 sin ) tanK D Xf g f¡ ¡= ³ - ³ ³ ³

D

g

0K

X

f¡

ForSand

ForClay
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P

ɼ

7. Addition of Multi-Linear type Elastic Link

Multi-linear type elastic link is newly added.  This feature is extremely useful when we model 

bi-linear springs between bridge decks and rails to evaluate axial forces in the rails considering 

nonlinear behavior of ballast due to a temperature and braking load.

Model > Boundaries > Elastic Link
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8. Nonlinear Point Spring Supports for Construction Stage Analysis

NonlinearPoint SpringSupportscan be now considered

in ConstructionStageAnalysis.

Point springsupportscan be applied to simulateelastic

bearingpadswhenanalyzingbridgestructures.

Following types of Nonlinear springs are can be

consideredin constructionstageanalysis.

- Compressiononly spring

- Tensiononly spring

- Multi -Linearspring

Model > Boundaries
> Point Spring Supports

9. Consider Accidental Eccentricity for Response Spectrum Analysis

in Basement Floors

AccidentalEccentricityfor ResponseSpectrum

Analysisin basementfloors can be considered

by checkingon the optionΨ/ƻƴǎƛŘŜǊEccentricity

belowG.[Ωoption. Defaultsettingischeck-on.

Load> Response Spectrum Analysis Data
> Response Spectrum Load Cases
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10. Considering Mass Participation Factors for Rotational Directions

Massparticipation factors for all the rotational directionscanbe calculatedregardlessof the

άCƭƻƻǊ5ƛŀǇƘǊŀƎƳέ. In the old version,massparticipationfactorsfor transferdirectionswere

onlyconsideredif άCƭƻƻǊ5ƛŀǇƘǊŀƎƳέisnot considered.

Results > Vibration Mode Shape

Results > Result Tables > Vibration Mode Shape

Old version Gen 2010

Vibration Mode Shape

Vibration Mode Shape Table



Gen 2010Enhancements in analysis part Gen 2010 (v1.1) Release Note

39/64

11. Transfer reactions of slave nodes to the master node

Analysis > Main Control Data

[Checked off - When reactions of slab nodes are 
not transferred to the master node]

[Checked on - When reactions of slab nodes are
transferred to the master node]

In the old version,reactionswere producedat the master node only when rigid links were

assigned. In Gen2010, the user can select if reactionsof slavenodesare transferredto the

masternodeor not.

When this option is checkedon, reactions of slave nodes are plotted as zero and total

reactions including reactions of slave nodes are plotted in the Summation field of the

ReactionsTable. When this option is checkedoff, reactionsof slavenodesare plotted in the

reactionfield of the correspondingslavenode.
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12. Improvements in Buckling Analysis Control dialog

SturmSequenceCheckoption for detectingany missedbucklingload factor and LoadFactor

Rangeoption for settingthe rangeof the bucklingloadfactor havebeennewlyadded.

midas Gen consideredLateral-TorsionalBucklingmode in any case. The FrameGeometric

StiffnessOption is newly implemented to ignore the Lateral-Torsional Buckling effect in

BucklingAnalysis.

Analysis > Buckling Analysis Control

[Message window]

[Buckling mode shape]

[Buckling mode shape table]

1st 2nd 3rd
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13. Improvements on the Eigenvalue analysis 

considering the maximum number of frequencies

When the Number of Frequenciesexceedsthe maximum number of eigenvaluesfor a

correspondingstructure,the programautomaticallyupdatesthe numberof frequencies. In the

old version,error messagewasdisplayedandanalysiswasterminated.

Old version Gen 2010

Analysis > Eigenvalue Analysis Control
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14. Improvement on FEMA type pushover hinge properties 

In the old version, M/MY at the point D and E must have the same value. In Gen 2010, 

ŘƛŦŦŜǊŜƴǘ ǾŀƭǳŜǎ Ŏŀƴ ōŜ ŘŜŦƛƴŜŘΦ Lǘ ƛǎ ŀǇǇƭƛŎŀōƭŜ ǿƘŜƴ ǘƘŜ LƴǘŜǊŀŎǘƛƻƴ ¢ȅǇŜ ƛǎ ΨbƻƴŜΩ ŀƴŘ LƴǇǳǘ 

aŜǘƘƻŘ ƛǎ Ψ¦ǎŜǊ LƴǇǳǘΩΦ 

This function is implemented to support the integration between SERCB win and midas Gen.

Design > Pushover analysis > Define Pushover Hinge Properties

[Pushover analysis result in Gen]

[SERCB win]



Gen 2010Enhancements in analysis part Gen 2010 (v1.1) Release Note

43/64

15. Considering buckling load in the Pushover Yield Surface 

In the pushover PMM hinge

properties, buckling load can be

considered in calculating yield

strengthby checkingon the ΨCalc.

YieldSurfaceof Beamconsidering

BucklingΩoption.

Design > Pushover > Pushover Global Control

16. Considering self-weight in the Pushover Analysis

In the old version, self-weight for beam members were only considered in pushover analysis. It 

is now considered for all the member types. 

17. Improvements in Inelastic Hinge Properties of SRC Beam member

Inelastic hinge can be now defined for SRC(encased) beam members. In the old version, 

inelastic hinge was not able to be assigned to SRC(encased) beam elements. 

Model > Properties > Inelastic Hinge Properties
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ÇDetailed Enhancement List in Design part

(1) Addition of Capacity Design as per NTC2008 and Eurocode8-
1:2004

(2) Addition of Slab/Wall Design as per Eurocode2-1-1:2004

(3) Improvements in Rebar Input Dialog

(4) Update rebar by members

(5) Addition of new rebar DB UNI standard 

(6) Improvement in calculating effective length in the steel 
structure according to the Chinese specification

(7) Addition of torsional design of RC beam as per TWN-USD92

(8) Addition of steel code checking as per IS:800-2007

(9) Auto-generation of load combination as per KBC 2009

(10) Addition of SRC Code Checking as per JGJ318-01
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1. Addition of Capacity Design as per NTC2008 and Eurocode8-1:2004

Capacity design provisions are required to

obtain the hierarchy of resistance of the

various structural componentsnecessaryfor

ensuringthe intended configurationof plastic

hingesandfor avoidingbrittle failuremodes.

In framebuildings,includingframe-equivalent

systems, with two or more stories, the

following condition should be satisfied at all

joints of primary or secondaryseismicbeams

with primaryseismiccolumns:

Gen 2010 midas Gen provides automatic

capacitydesignto satisfythe specifiedductility

classes(DCMand DCHfor Eurocode8, CDά.έ

andCDά!έfor NTC2008).

Design > Concrete Design Parameter 
> Design Code

Design > RC Strong-Column Weak-Beam Design 
> Ductile Design/Ductile Checking

Design > Concrete Code Design 
> Beam Design / Column Design / Wall Design

(1) Define design code: 

(2-1)Perform Design : 

Rc RbM 1.3 M²ä ä
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Where,MRb: Beam moment resistance

k1: factor for considering torsional effect in building

Mce: column member force due to seismic load case

Mbe: beam member force due to seismic load case

ÇBeam and Column Design forces for DCM & DCH as per EC8-1:2005

MRb: Beam moment resistance

MRc: Column moment resistance

Rɹd: Factoraccounting for overstrength 

Rɹd DCM/CD"B" DCH/CD"A"

beam 1 1.2
column 1.1 1.3
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ÇWall Design forces for DCM & DCH as per EC8-1:2005
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DetailReport

GraphicReport

Design Result Dialog

Design Results

Theautomaticdesignresultsare basedon the maximumnegativeand positivemomentsand

shearforcescalculatedat the positions(I,1/4,1/2,3/4 & J)of eachmemberin accordancewith

the loadcombinationsfor concretedesign. Detailedcalculationcanbe checkedin the graphic

report anddetail report.
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2. Addition of Slab/Wall design as per Eurocode2-1-1:2004

Slaband wall designfor meshedplate elementsis newly implementedas per Eurocode2-1-

1:2004. SlabFlexuraldesign& checking,Slabpunchingshear checkingand Wall design&

checkingfeaturesareavailable.

Text Output Two-way Shear Check (Punching Shear Check)

Design> Meshed Slab/Wall Design > Slab Flexural Design

Slab Shear Checking

Slab Flexural design : Required rebar area Rebar type and Spacing

Slab Serviceability Checking

Wall Design
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Design> Meshed Slab/Wall Design > 
Slab/Wall Load Combination

Design> Meshed Slab/Wall Design > 
Design Criteria for Rebar

Load combination for slab and wall design

Load combination for slab and wall design

can be chosen in this dialog. All the load

combinationsgeneratedin the SlabDesign

tab Load Combination dialog (Results >

Combinations) are displayed here. This

function is useful when the engineerneeds

to apply some of the load combinations

suchasgravityloadsfor slabdesign.

Defaultsettingis checking-on for all the load

combinations.

Specify reinforcement data for slab and wall design

Enter the standard sizes

of rebars, spacing and

concretecoverdimension

in the designof slab,mat

foundation and wall

members.

Coverdimension for slab

can be differently

specified for top and

bottom rebars.
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Design> Meshed Slab/Wall Design > 
Slab Flexural  Design

Flexural design

Flexuraldesignresultsfor slabelementsare

provided in contour, detail report and

designforcetable.

Followingresultsare provided from flexural

design:

Rebarspacinganddiameter

Requiredrebararea

Requiredrebar ratio

Resistanceratio

WoodArmerMoment

Wood-Armer moment: midas Gen provides design forces in the reinforcement 
directions for skew reinforcement based on the Wood-Armerformula.

From the analysis results, following plate forces 
about the local axis are calculated
Åmxx

Åmyy

Åmxy

In order to calculate design forces in the 
ǊŜƛƴŦƻǊŎŜƳŜƴǘ ŘƛǊŜŎǘƛƻƴΣ ŀƴƎƭŜ ʰ ŀƴŘ w˒ill be taken 
as adjacent figure.

Where
x, y: local axis of plate element
1, 2: reinforcement direction

:h angle between local x-direction and reinforcement 
direction 1

:˒ angle between reinforcement direction 1 and 
reinforcement direction 2
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Firstly, internal forces (mxx, myy and mxy) are transformed into the a-b coordinate system.

Then, Wood-Armer moments are calculated as follows:
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DesignResult

Detailedcalculationresultsare provided in the

detail report.

DesignForce

Wood Armer moments are provided for a

specified load case/combination in a spread

sheet format. When All Combination is

selected, the most unfavorable Wood-Armer

momentsare displayedwith the corresponding

loadcombinationfor eachplateelement.

UpdateRebar

Reinforcementresultingfrom flexuraldesignare

automaticallyupdated.

Design> Meshed Slab/Wall Design > 
Slab Flexural  Design

Flexural design report, table and update rebar

Detail report

Meshed Slab Design Force table Update Rebar
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Slab Rebars for checking

Rebarfor slabandwall checkingcanbe assignedandreplacedin this dialog. Rebardirection is

specifiedin the Sub-domaindialog.

Design> Meshed Slab/Wall Design > Slab/Wall Rebars for Checking
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For practicaldesign,smooth moment distributions

are preferred. By selectingthe smoothing option,

the program can considerthe smooth moment in

slabdesign.

Smoothing

Element: Designresults are displayedusing the internal

forcescalculatedat eachnodeof elements. (nosmoothing)

Avg. Nodal: Designresultsare displayedusingthe average

internal nodal forces of the contiguouselements sharing

the commonnodes.

(Example)Designforce for Node. EN21
In oneplate element,4 internal forcesexist. Forthe element
E2, memberforcesexistat the node EN21, EN22, EN23 and
EN24. Followingequationsshowhow the smoothingoption
works for the node EN21. (Assumethat rebar direction is
selectedasAngle2 for Width smoothingdirection.)

(1) Element+ Element: EN21
(2) Avg. Nodal+Element: (EN12+EN21+EN33+EN44)/4
(3) Element+ Width 2m: (EN11+EN12+EN21+EN22)/4

Element: Designresultsare producedfor momentsat each

nodeof slabelements. (nosmoothing)

Width: Design result of slab elements at each node is

producedusingthe averageof the bendingmomentsof the

contiguousslabelementswith the specifiedwidth.

Avg. Nodal of EN33 =
(EN12+EN21+EN33+EN44)/4

Width 2m of EN33 =
(EN33+EN34+EN43+EN44)/4

2m

Average Nodal and Width smoothing

2m
1

2

EN73

EN72

EN83

EN82

(4) Avg. Nodal+ Width 2m: {(EN11+EN34+EN72+EN83)/4 + (EN12+EN21+EN33+EN44)/4
+ (EN22+ EN43+ EN51+EN64)/4 }/3

Design> Meshed Slab/Wall Design > 
Slab Flexural  Design



Gen 2010Enhancements in design part Gen 2010 (v1.1) Release Note

56/64

One-Way Flexural Design

Producethe slab design results of the floor slab

elements along a cutting line. In one-way flexural

design,Wood-Armermomentsperpendicularto the

cuttingline areapplied.

Rebardimensionwith spacing,Requiredrebararea,

required rebar ratio and resistance ration is

displayedin contours.
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Slab Shear Design

Producethe punching shear check results at the

critical perimeter of slab supports or the loaded

pointsof concentratedloadsandthe one-wayshear

check results along the user-defined ShearCheck

Lines.

ÇPunching shear calculation

ÁMaximum shear stress calculation

Case 1. vEd : platestressfrom analysis

Shear stress 
for each side

Design> Meshed Slab/Wall Design > 
Slab Shear Checking

Shearstressaverageby Element

averageby Side

Detail report

Shear stress at the critical perimeter

V_Ed  < V_Rd,c  : section is safe in punching shear
V_Ed  > V_Rd,c  : provide shear reinforcement.
Asw/sr     = (v_Ed-0.75*v_Rd_c)*(u1*d) / (1.5*d*fywd_ef)
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Ed

Ed

i

V
v

u d
=bCase 2. 

In this case, the program takes the axial force in the column supporting the slab as the shear 
force (V_Ed). The basic control perimeter (u1) is taken at a distance 2d from the column face 
(as shown in the diagram below)

The maximum shear force is calculated by multiplying V_Ed with shear enhancement factor 
ʲΦ ¢ƘŜ ǾŀƭǳŜ ƻŦ ʲ ƛǎ ŘƛŦŦŜǊŜƴǘ ŦƻǊ ŘƛŦŦŜǊŜƴǘ ŎƻƭǳƳƴǎΦ όŀǎ ƎƛǾŜƴ ƛƴ ǘƘŜ ŎƻŘŜύ

Internal rectangular Column Uniaxial

bending

Internal rectangular Column biaxial bending

Rectangular Edge Column: axis of bending 

parallel to slab edge, eccentricity is 

towards interior.

Rectangular Edge Column: axis of bending 

parallel to slab edge, eccentricity is 

towards exterior.

Rectangular Edge Column: bending about 

both the axes, eccentricity 

perpendicular to slab edge is 

towards interior. k = determined from Table 6.1 with the ratio 

ΨŎмκŎнΩ ǊŜǇƭŀŎŜŘ ōȅ ΨŎмκнŎнΩ

Rectangular Edge Column: bending about 

both the axes, eccentricity 

perpendicular to slab edge is 

towards exterior.

Rectangular Corner Column, eccentricity is 

towards interior

Rectangular Corner Column, eccentricity is 

towards exterior

Interior Circular column

Circular edge or corner column No information in the code.
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Slab Serviceability Checking

Design> Meshed Slab/Wall Design > 
Slab Serviceability Checking

StressChecking

Both compressivestressin concreteand tensilestress

in reinforcement is checkedwith the stresslimitation

specifiedin ServiceabilityParametersdialog.

When plate force exceeds cracked moment, the

program can automatically consider the cracked

sectionin stresschecking.

CrackControl

Crackwidth, minimumrebar areato control the crack,

maximumbar spacingand maximumbar diameter for

crack can be checkedin contour as well as detailed

report.

Deflection

Deflection for un-cracked section can be calculated

considering long-term deflection due to creep.

Deflectionfor crackedsectioncan be provided in the

upcomingversion.

Stress Checking

Crack Control

Deflection

Design> Meshed Slab/Wall Design > 
Serviceability Parameters
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Wall Design Design> Meshed Slab/Wall Design > 
Wall DesignWall design results are provided in contour, detail

report and design force table. Also concrete stress,

c̀d, canbecheckedwith f˄cd.

Followingresultsareprovidedfrom wall design:

Rebarspacinganddiameter

Requiredrebararea& Requiredrebar ratio

Resistanceratio

Meshed Wall Design Force table Detail report
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3. Improvements in Rebar Input Dialog

Rebarinput dialog hasbeen improved for better usability. Main rebar and stirrup for i-end,

middle and j-end can be simplyassignedand modified in the dialog. Assignedrebar data is

displayedin workstree. RebarcanbeassignedbyDrag&Dropfrom the tree menu.

Design> Concrete Design Parameter > Modify Beam/Column/Brace/Wall Rebar Data
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